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State Tax Commission Schedule 13

• Schedule 13 provides miles of line located in each taxing jurisdiction, except school districts, for all Missouri 

Counties. 

• Original Assessment (OA) sends each centrally assessed company a company-specific Schedule 13 with 

miles of line reported to the Commission from the prior tax year. 

• The company updates the Schedule 13 with any new miles of line to exactly two decimal places (one-hundredth 

of a mile).

• All taxing jurisdictions, active as of January 1, are listed for each county.  New entries for miles of line, by 

county, should be appropriately identified for the current tax year.  

• Companies should not send the Schedule 13 to a county with no miles of line. 

• The Schedule 13 must be submitted to OA and applicable counties by April 15. 
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2022

2022 Miles 2022 Miles Updated

• Schedule 13s have five types of  taxing jurisdictions: 

County Wide, Municipality, Special, Road, and 

Township. 

• Miles entered in the “2022 Miles” Column are the miles 

certified in the prior tax year.  Miles entered in the “2022 

Miles Updated” Column are the Company’s updated 

miles, if any, for the current tax year. 

• Companies only update miles in the “2022 Miles 

Updated” if miles changed from the prior year.

• If there is no change then the “2022 Miles Updated” 

column remains blank.

• If an Amendment takes place, the company and clerk 

must send an amended Schedule 13 to each other and 

OA.

ABC Company, Inc.
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2022

2022 Miles 2022 Miles Updated

• OA updates the “Taxing Jurisdictions by County” on the 

Schedule 13 in December each year.

• Clerks are responsible for adding new taxing 

jurisdictions at the bottom of Schedule 13, and notifying 

companies. OA uses this information, along with the 

State Auditor’s report, to update the Schedule 13 each 

December. 

• Any discrepancies noted on the Schedule 13 by the 

Clerk should be discussed with the company 

immediately upon receipt.

XYZ Township Linn County 1.00

ABC Company, Inc.
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State Tax Commission Form 40

• Clerks prepare the Form 40 with data from the certified Schedule 14s received 

from the Assessor.

• The Form 40, with the county clerk’s signature, date, and the county’s seal 

affixed, is the county clerk’s certification for each company’s miles of line in the 

county taxing jurisdictions, excluding school districts. (Section 151.040 RSMo).  

• The Form 40 and the associated Schedule 13 for each centrally assessed 

company must be certified and submitted by the county clerk to the Original 

Assessment Section (Section 151.040 RSMo) by May 15.

• The Form 40 assessed values are used as a reconciliation tool for the Original 

Assessment Section and the Administration Section in conjunction with the 

Form 11/11A.
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Navigate to Form 40

To navigate to the Form 40 on the STC’s website, Select the tab for the “Clerks” section and 

then the “Commonly Used Forms” link.
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Navigate to Form 40

Under the “Commonly Used Forms” banner, select the “2022 – Form 40_All Counties” link (third 

section down from the top).
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Navigate to Form 40

Download and open the “2022 – Form 40_All Counties” Excel workbook then select and 

save appropriate county worksheet. 
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Save Form 40 By County
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• Right click applicable County tab 

• Select “Move or Copy” and box pictured 

to the right will appear

• Select the “Create a copy” checkbox

• Click the “To book:” dropdown

• Select “(new book)” 

• Click “OK”
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Save Form 40 By County

After clicking “OK” the applicable County tab will now stand alone in its own Excel workbook. 
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Form 40 Data Placement
• Form 40 data comes from the 

Assessor certified Schedule 14, 

page 1.

• Take REAL Operating Property, 

Line 4 of Assessed Value and 

report on the Form 40 under Real 

Property, highlighted in Red.

• Take TANGIBLE PERSONAL 

Operating Property, Line 11 of 

Assessed Value and report on 

the Form 40 under Personal 

Property, highlighted in Green.

• Take TOTAL OPERATING 

PROPERTY, Line 12 of Assessed 

Value and report on the Form 40 

under Total Assessed Value, 

highlighted in Blue.

DO NOT INCLUDE NON-OPERATING PROPERTY REPORTED ON FORM 40  



ABC Company, Inc.

ABC Company, Inc.
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How to Digitally Sign the Form 40
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Stacey A. Cowan

YOUR TEXT HERE

• Click the “Insert” tab, then the “Text Box” icon, and a “Your Text Here” box will appear

• Type your “Name” in the “Text Box”, then drag and drop the “Text Box” with “Name” to appropriate location
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Stacey A. Cowan

05-15-2022Stacey A. Cowan

• Type “Name” in the “Signature of County Clerk” text field

• Type “Date” in the “Date” text field

• You may change font, size, or color if desired

How to Digitally Sign the Form 40, cont.



How to Affix County Seal to the Form 40

15

• Find County Seal

• Google

• Your website

• In your office

• Save image to your desktop
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• Click the “Insert” tab, then the “Pictures” icon, and an “Insert Picture” box will appear

• Navigate to saved image location, i.e.; “Desktop”, and select “Seal Image”, then click the “Insert” button

How to Affix County Seal to Form 40, cont.



How to Affix County Seal to Form 40, cont.
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Stacey A. Cowan

Stacey A. Cowan

• County Seal will appear. You may change size and move to desired location

• E-signature Block is now complete, with; “Text Box” name, “Typed” Signature & Date, and Picture Insert of 

County Seal

05-15-2022



Ways to Send the Form 40 and Schedule 13s to OA
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Combine the Form 40 Excel worksheet with all the Schedule 13 Excel worksheets and send to 

OA in one Excel workbook. – PREFERRED1.

Subject: Must include; 

• Year

• County Name

• Contents being sent

Attachment: Must include; 

• Year

• County Name

• Form or Schedule Name

Send to; 

originalassessment@stc.mo.gov

or via FTP in same format 

mailto:originalassessment@stc.mo.gov


How to Save Form 40 and Schedule 13s in One Workbook
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• Open Form 40 Excel 

workbook

• Move company Schedule 13s 

to the Form 40 Excel 

workbook

• Save each company Schedule 

13 in the Form 40 Excel 

workbook in the same order 

as the Form 40

• Double click the company 

Schedule 13 tab to rename 

with company account number



How to Save Form 40 and Sch. 13s in One Workbook cont.
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• Open Schedule 13s one at a time to 

move and save to the “Form 40 and 

Schedule 13” Excel workbook

• Once the company Schedule 13 is 

open, right click the tab at the bottom

• Select “Move or Copy” and box 

pictured to the right will appear

• Select the “Create a copy” checkbox

• Click the “To book:” dropdown

• Select “Form 40 and Schedule 13 

Excel Workbook”

• Click “(move to end)” and click “OK”



How to Save Form 40 and Sch. 13s in One Workbook cont.
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• Once all Schedule 13s are 

moved to the Form 40 and 

Schedule 13s Excel workbook

• Save and send via email as one 

attachment to: 

originalassessment@stc.mo.gov

mailto:originalassessment@stc.mo.gov


Ways to Send the Form 40 and Schedule 13s to OA
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Modify Excel worksheet with adequate Print Selection, save as PDF, and send to OA as 

individual PDFs.2.
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• From the “View” tab, click “Page Break 

Preview”.

• Blue dotted lines will appear, indicating 

the print page.

• Move “Rows” and “Columns” within the 

blue dotted print lines as needed.

• Simply drag and drop blue dotted line to 

desired location.

Modify Excel Worksheet Print Selection & Save as PDF
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Modify Excel Worksheet Print Selection & Save as PDF, cont.
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• Line 17 “North Stone County-Northeast 

Barry County FPD” of the Schedule 13 

will now print to Page 1.

• Page Breaks can go up and down, or left 

and right.

• Once this is complete, everything moved 

within the blue dotted lines, will print to 

chosen page.

Modify Excel Worksheet Print Selection & Save as PDF, cont.
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Modify Excel Worksheet Print Selection & Save as PDF, cont.



27

• Note – Ensure that print area is set up 

in Excel before saving to PDF

• Click the “File” tab and select “Save as 

Adobe PDF”

• Select the “Sheet(s)” button under 

“Conversion Range”

• Select the “Fit to paper width” button 

under “Conversion Options”

• Click “Convert to PDF”

• Error message may appear, click “Yes”

Modify Excel Worksheet Print Selection & Save as PDF, cont.
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• Type, 2022 Form 40 – Adair County 

in the “File Name” text box

• Select Location you wish to save, i.e.; 

Desktop

• Click the “Save” button

• Send via email as individual PDF 

attachment to: 

originalassessment@stc.mo.gov

Modify Excel Worksheet Print Selection & Save as PDF, cont.

mailto:originalassessment@stc.mo.gov


Ways to Send the Form 40 and Schedule 13s to OA
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Combine the Form 40 and Schedule 13s in One PDF Attachment Using Adobe Acrobat.3.

Subject: Must include; 

• Year

• County Name

• Contents being sent

Attachment: Must include; 

• Year

• County Name

• Form or Schedule Name

Send to; 

originalassessment@stc.mo.gov

or via FTP in same format 

mailto:originalassessment@stc.mo.gov


How to Combine the Form 40 and Schedule 13s in 

One PDF Attachment Using Adobe Acrobat

30

• Open Acrobat to combine files; Open the Tools tab 

and select “Combine files”

• Add files; Click “Add Files” and select the files you 

want to include

• You can merge PDFs or a mix of PDF documents

• Arrange and delete content; Click, drag, and drop to 

reorder files or press “Delete” to remove any content 

you don’t want

• Combine files; When you are finished adding and 

arranging, click “Combine Files”

• Save as a PDF file; Name your file and click the 

“Save” button



How to Combine the Form 40 and Schedule 13s in 

One PDF Attachment Using Adobe Acrobat
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How to Combine the Form 40 and Schedule 13s in 

One PDF Attachment Using Adobe Acrobat
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How to Combine the Form 40 and Schedule 13s in 

One PDF Attachment Using Adobe Acrobat
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How to Combine the Form 40 and Schedule 13s in 

One PDF Attachment Using Adobe Acrobat
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How to Combine the Form 40 and Schedule 13s in 

One PDF Attachment Using Adobe Acrobat
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• Type, 2022_Adair County_Form 40 

and Schedule 13 in the “File Name” 

text box

• Select Location you wish to save, i.e.; 

Desktop

• Click the “Save” button

• Send via email as individual PDF 

attachment to: 

originalassessment@stc.mo.gov

mailto:originalassessment@stc.mo.gov


Ways to Send the Form 40 and Schedule 13s to OA
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Combine the Form 40 with all the Schedule 13s and send to OA in one scanned PDF.

ORGANIZE Schedule 13s in the same order as the Form 40 list of companies.
4.

Subject: Must include; 

• Year

• County Name

• Contents being sent

Attachment: Must include; 

• Year

• County Name

• Form or Schedule Name

Send to; 

originalassessment@stc.mo.gov

or via FTP in same format 

mailto:originalassessment@stc.mo.gov


How to Send the Form 40 and Schedule 13s to OA
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• When scanning the Form 40 and Schedule 13s in one document/attachment, sequence the 

Schedule 13s per the Form 40 list order.



Things to Double Check Before Sending the Form 

40 and Schedule 13s to OA
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• Do the figures on the Form 40 match the Assessed Value per the Schedule 14

• Is there an “X” on the Form 40 for companies with a Schedule 13

• Is the Signature Block complete

• Does the Subject Line in the email include; Year, County Name, and items enclosed

• Do the attachments enclosed in the email include; Year, County Name, and Form or Schedule 

name

• Are all the Schedule 13s included with the Form 40 submission

• Be sure to send the Final Schedule 13 to OA with the Form 40 submission

• Contact company with any questions, concerns, or missing items



State Tax Commission - Original Assessment

For additional assistance contact:

• Stacey Cowan, Appraisal Specialist – 573-751-1708

• Peter Chari, Appraisal Specialist – 573-751-1729

• Jeffrey Smith, Manager – 573-526-6403



Questions

40



Form 11 and Form 11A

State Tax Commission of Missouri

Administration

2022 Missouri State Clerk’s Conference



Form 11 & Form 11A
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• County assessors are required by statute to turn over the assessment book 

by July 1st each year.  

• County clerks are required by statute to submit a Form 11 by July 20th each 

year.

• Upon adjournment of the Board of Equalization, county clerks are required 

to submit a Form 11A.

• Statutes allow for amendments to both Form 11 and Form 11A prior to 

December 31st of each year (STC prefers an amended Form 11A 

submission by December 15th-20th to capture changes from the BOE to end 

of year).



Form 11 & Form 11A (Back)

43

• Complete the back of the Form 11 or 11A FIRST

• The information on the back of the Form 11 and 11A is used for reporting 

and auditing purposes. 

• There are formulas that will auto-populate the county name throughout the 

entire spreadsheet, if entered on the Form 11 back tab first. 

• Total fields in each section have formulas that will calculate the values.  



Form 11 and Form 11A (Back)
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• New Construction figures 

come from the assessor's 

assessment book.  The 

clerk is responsible for 

adding the new 

construction from all 

locally assessed property 

of the centrally assessed 

companies.  Line 17 from 

the Schedule 14.

• TIF Incremental Finance 

Property – only the 

amount of the TIF 

incremental increase is 

reported on the back of the 

Form 11 and Form 11A.



Form 11 and Form 11A (Back)
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• Locally Assessed 

REAL OPERATING 

Property for Centrally 

Assessed Railroad 

and Utility 

Companies – includes 

all REAL OPERATING 

property from the 

Schedule 14, Line 4.  

This should also be the 

same number from the 

Form 40 total real 

property.



Form 11 & Form 11A (Back)
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• Vehicles/HISTORICAL 

MOTOR VEHICLES 

(these blocks are a 

count of vehicles, not 

assessed values) – the 

vehicles counts are 

provided by the assessor's 

assessment book.  The 

Clerk is responsible for 

including vehicles from the 

locally assessed property 

of the centrally assessed 

companies.  This can be 

found on SCHEDULE 16.

• Each of these block totals 

auto populate on lines 20 

and 23 on the front, 

respectively.



Form 11 & Form 11A (Back)
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• Signature Block – this should be completed by the county clerk.  Ensure the box is checked which takes 

the place of the county clerk seal allowing for the acceptance of electronic submissions.

• Completing the Form 11 Back tab first will auto populate data throughout the workbook.



Form 11 & Form 11A (Front)
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What goes on the FRONT of the Form 11 and 11A?

• ASSESSED VALUE FOR ALL LOCALLY ASSESSED TAXABLE PROPERTY

• Inclusive of Rural Electric Cooperatives and Locally Assessed Railroad and Utility Property that is 

NOT valued by the State Tax Commission (both operating and non-operating property).

• TIF – Base and Incremental Increase

• Urban Redevelopment 

• Enterprise Zone

• All locally assessed personal property

• Inclusive of Rural Electric Cooperatives and Locally Assessed Railroad and Utility Personal Property 

that is NOT valued by the State Tax Commission (both operating and non-operating property.

What does NOT go on the front of the Form 11 and Form 11A?

• Centrally (State) Assessed Railroad and Utility Assessed Values

• Chapter 100 Assessed Values



Form 11 (Front)

49

• Real Property Total Assessments and Values – be sure to include the number of assessments for each 

subclass of property inclusive of railroad and utility property.  Split between rural and incorporated town lots.

Residential                               Agricultural                            Commercial                           Forest Cropland



Form 11 (Front)
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Personal Property Total Assessments and Values

• Horses, Mares, Asses, Jennets, and Mules

• Cattle

• Hogs

• Sheep & Goats

• Poultry

• All Other Livestock



Form 11 (Front)
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Personal Property Total Assessments and Values

• Vehicles (be sure to include assessed valuation from 

Locally Assessed Railroad and Utility Vehicles found on 

Schedule 16 or Schedule 14, Line 5, if not already 

included in assessor's assessment book.)

• Grain and Other Agricultural Crops

• Manufactured Homes (only personal property mobile 

homes)

• Historical Motor Vehicles and Aircraft & Aircraft Built from Kit

• All Other Tangible (be sure to include business personal 

property from the Schedule 14, Lines 6, 7, 8, 9, and 10)

• Pollution Control Tools and Equipment

• Farm Machinery



Form 11A (Back)

52

What changes on the back of the Form 11A from the Form 11?

• New Construction – the residential subclass for occupancy counties 

should be the only change (unless there is an error or an error corrected 

through the BOE.

• TIF – A TIF agreement expired.

• Locally Assessed Real Operating Property – the Form 40 has been 

amended.

• Vehicles and Historic Motor Vehicles, Historical Aircraft, and Aircraft 

Built from a Kit – counts should be updated, if there are any changes.



Form 11A (Front)

53

Form 11 assessed values auto populate in the first column of the 

Form 11A.

• If you amend the Form 11 after the Form 11A has been submitted, 

an amended Form 11A will also need to be submitted.

• Reminder – either form can be amended until December 31st. 

• No forms can be accepted after December 31st of that year.



Form 11A (Front)
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Valuation 

Deducted by 

BOE – enter 

negative 

values in this 

column.

Other Valuation 

Changes –

enter positive 

or negative 

values in this 

column.

This column 

is auto 

populated 

from the Form 

11 Front tab.

Valuation 

Added by 

BOE – enter 

positive 

values in this 

column.



Form 11A (Front)
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Chapter 100 Report

56

• Chapter 100 assessed value is not 

included on the Form 11 and Form 11A.

• Schools are allowed to utilize the Chapter 

100 assessed valuation to increase their 

bonding capacity.

• Schools are allowed to bond up to 

15% of their district’s taxable tangible 

property.

• If the county assessor does not provide 

the information, please submit the 

document with a zero and indicate the 

assessed values were not provided.



Submission of the Aggregate Abstract

Form 11, Form 11A, and Chapter 100 Report

57

• Print/save the forms in PDF format for electronic submission to the State Tax 

Commission.

• Email forms to stc@stc.mo.gov.

• Contact the Administrative Secretary for county specific questions.

Stacey Jacobs

573-751-1716

Stacey.Jacobs@stc.mo.gov

mailto:stc@stc.mo.gov
mailto:Stacey.Jacobs@stc.mo.gov


Assessed Valuations

58

• Why it is important to keep locally assessed 

and centrally assessed valuations separate?

• When the STC compiles the annual report 

data at the end of each calendar year…

• the locally assessed valuations are 

pulled from the Form 11A submitted by 

the counties (top section)

• the centrally assessed valuations are 

pulled from the Original Assessment 

program (bottom section)

• These are combined to provide a total 

county assessed valuation.



Utilization of the Form 11 and Form 11A Information
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• Missouri Association of Counties - Used for classification of counties, appropriation of membership 

dues, etc.

• County Employee’s Retirement Fund – Utilizes the data for auditing functions

• Legislative Oversight Division and Senate Research – Legislative utilizes for proposed legislation

• University of Missouri – Statistical information on web site

• Department of Elementary and Secondary Education – Utilizes the data as an audit function to 

compare with December 31st assessed valuations submitted by each County Clerk

• State Auditor’s Office – Official classification of counties

• Secretary of State’s Office - Publish in the Missouri Roster

• Missouri State Library - Statistical data 



Utilization of the Form 11 and Form 11A Information
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Department of Revenue

• County Aid Road Trust (CART) Funds – As mandated by Article IV, Section 

30(a).1, Missouri Constitution (as amended 1979)

• Approximately $110 million annually are disbursed to the counties

• CART Funds are apportioned on the basis of two factors

• Half of the funds are credited on the ratio a county’s road mileage bears to the total county 

road mileage in the unincorporated areas of the state (MoDOT)

• Half of the funds are credited on the ratio that county rural land valuation bears to the rural 

land valuation of the entire state (STC’s final reported assessed valuations)



Common Issues for 2022
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• Be sure to include the locally assessed railroad and utility property on both the front and back of the 

Form 11/11A.  Use the Schedule 14 as a check list for each company.  Every number on that form 

belongs on the Form 11/11A.

• Include new construction on the back of the form from the locally assessed railroad and utility property.  

You can find this on Schedule 14, Line 17.  The breakdown for rural or incorporated town lots will be 

included on the supporting forms and schedules.

• Locally Assessed Real Operating Property should match the Form 40.  Review the Form 40 and 

supporting documentation when completing this block.  This is over 50% of my contact to correct with 

clerks.

• Include vehicle counts and assessments from the locally assessed railroad and utility property.  

Schedule 16 provides the count and assessed valuation for vehicles.

• Keep data entry consistent.  Example – if heavy machinery was included in Line 25 (all other tangible 

personal property), don’t move it to Farm Machinery (Line 19).



Quarterly Reimbursement Form

State Tax Commission of Missouri
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2022 Missouri State Clerk’s Conference



Quarterly Reimbursement Form
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• The Quarterly Reimbursement Form should be completed by the Clerk and submitted to the 

State Tax Commission on a quarterly basis.

• Quarters are based on the State’s fiscal year

Quarter Months Due to STC

First Quarter April – June Due August 15th-ish

Second Quarter July – September Due October 31st

Third Quarter October – December Due January 31st

Fourth Quarter January – March Due April 30th



Quarterly Reimbursement Form
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• The Quarterly Reimbursement workbook has been designed to make data 

entry easier.  Utilizing the same workbook for the entire fiscal year will auto 

populate data across the multiple tabs of the workbook.

• The workbook contains the following tabs

• Instructions

• Reimbursable Expenses

• Non-Reimbursable Expenses

• April – June Data Entry

• April – June Reimbursement

• July – Sept Data Entry

• July – Sept Reimbursement

• Oct – Dec Data Entry

• Oct – Dec Reimbursement

• Jan – March Data Entry

• Jan – March Reimbursement



Quarterly Reimbursement Form
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• Complete the workbook in order of the 

tabs. 

• The Data Entry tab for each quarter 

allows the expenses to be entered on 

the appropriate line and then entered 

on the Quarterly Reimbursement form 

on the correct line.

• The Data Entry tab replaced the 

calculator tape requirement.



Quarterly Reimbursement Form
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• Once you have completed the 

April-June data entry tab, click 

on the April-June 

Reimbursement tab.

• In the upper left corner, select 

your county from the dropdown 

list.  This will populate the 

correct parcel count and 

complete the proper calculations.

• Enter the total number of 

employees, not including the 

assessor on Row B.

• Enter any mileage and the 

county mileage reimbursement 

rate on Line 2.



Quarterly Reimbursement Form
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• Once all entry has been completed on the data entry tab and on the form itself, the 

Calculations section will automatically calculate Lines 1-6.

• This only works as long as the county is selected at the top of the form for the 

April – June Reimbursement tab.



Quarterly Reimbursement Form
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• The form is ready for 

signatures from the 

county officials –

Assessor, Presiding 

Commissioner/Chief 

Executive, Accounting 

Officer and Clerk.

• Electronic seal or 

scanned seals are 

allowable.  The scanned 

seal must be visible on 

the scan to be accepted.

• A PDF digital signature, 

displayed here, is also 

accepted.



Quarterly Reimbursement Form
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• Once the form is completed, all signatures have been applied, and the seal 

has been applied/affixed, scan all supporting documentation to be submitted 

with the reimbursement form.  Please scan the supporting documentation in 

the order it is entered on the data entry tab.

• Submit the form and supporting documentation to stc@stc.mo.gov.  If the file 

is too large to send via email, you can submit via FTP (https://moftp.mo.gov) 

or break into multiple emails.

• If you have any questions regarding the form please contact our office.

Misty Frank

573-751-1735

Misty.Frank@stc.mo.gov

mailto:stc@stc.mo.gov
https://moftp.mo.gov/
mailto:Misty.Frank@stc.mo.gov


Quarterly Reimbursement Form
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• Once the form has been 

audited and signed at the 

State Tax Commission, 

payment is processed.

• If adjustments were made 

to the reimbursement, 

these are recorded and 

notes are provided on the 

reimbursement form page 

when sent back to the 

county.

• After you have reviewed 

the notes, update the 

corresponding quarter to 

ensure the workbook is 

correct and ready for the 

next quarter.



Quarterly Reimbursement Form Common Errors
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• Counties forget to select their county from the dropdown list on the April –

June Reimbursement form.  This is necessary for the proper parcel count 

to display and for the Calculations to work correctly.

• Counties forget to update their workbook if adjustments were made by the 

STC.  Not updating the previous quarter with the STC adjustments will 

have all remaining quarters miscalculating the reimbursement amount.

• Future expenses are not allowed.

• Examples:  Assessors’ Conference is in October, but the county paid 

for it in August/September.  This cannot be reimbursed until the actual 

event has occurred; therefore, this expense should be on the October-

December reimbursement.



Questions

72


